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Process Overview 
 
 
There are four principle steps in Network Installations: 

 
1. Downloading the installation image and the permission key from the CCH Software Delivery 

Manager. 

2. Install the application software 
 

3. Setup the Fixed Assets Manager databases 
 

4. Setup the workstations 
 

 
Below are detailed instructions for each of the above steps. 

 
 
 
Downloading the installation image from Software Delivery Manager 

 
1. Install Software Delivery Manager if you have not already done so. 

 
o To find out how to install Software Delivery Manager (click here) - 

(https://support.cch.com/kb/solution.aspx/sw43658) 
 

2. Download the file to install CCH Fixed Assets Manager using Software Delivery Manager. 
 

o To find out how to use Software Delivery Manager to download installation files (click here) - 
(https://support.cch.com/kb/solution.aspx/sw43910) 

 

 
 
 
 
 
Running the Installation Process 

 
At this point, you have downloaded the installation files and the permission key to install CCH Fixed Assets 
Manager using the instructions above. If you need assistance please contact CCH customer support at 
800.739.9998, Option 2 then Option 3. 

 
 
 
To install the Fixed Assets Manager (FAM) program version 2021.01 

 
1. Close all applications running in Windows®. 

 
2. Important: If this is the initial installation of FAM, the computer may shut down and restart during the 

installation. Therefore, we highly recommend saving your work and closing all applications running on the 
workstation before installing the Fixed Assets Manager program. 

 
3. Navigate to the location where you downloaded the installation files archive from the Software Delivery 

Manager. Right Click on the fam-2021.01000.exe and select ‘Extract’. 
 

4. After the extraction is complete, right click on the Setup.exe file and select “Run as administrator”. 
When the User Account control window opens, select Yes to continue. 
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5. The Fixed Assets Manager Master Setup screen opens. Select Install. 
 

 
 

6. The Welcome screen opens. To continue, click Next. 
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7. The Permission Key Installation opens. Browse to the PermKey folder at the location where the 
application was downloaded from the Software Delivery Manager. Select the ‘fxperm02’ file. Click Next. 

 

 

 

 
 

 
 
 
 

8. Setup Type selection opens. 
 

 
 
 

9. Two installation options are available: 
 

10. Local - Installs Fixed Assets Manager on the current workstation. Not applicable for Network installation 
(Not recommended). 

 
11. Network - Installs Fixed Assets Manager to a shared drive for access by multiple users 

(Recommended). 

NOTE:  The 2021.01 release requires a 2021 Permission Key to be downloaded 
from the Software Delivery Manager. If you use a prior year Permission Key, you will 
receive a message that ‘The Key selected is invalid’. 
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12. Click Network. Choose Program Destination opens. 
 

 
 
 
 

13. You can change or accept the default locations of the program files folder. To accept the default location, 
click Next. 

 
14. To change the locations, click the Browse button, select the new destination on Choose Folder, and 

click OK. To continue, click Next. 
 

15. Product Selection opens. Select Fixed Assets Manager, if it is not already selected, and click Continue. 
 

16. After all files are successfully copied, Setup Complete opens. 
 

17. The Microsoft® Visual C++ 2015 Redistributable (x86) is required for the proper functioning of the FAM 
software. When prompted, select Yes to continue or select No to exit the installation. 

 
18. Microsoft® .NET Framework is required for the proper functioning of the FAM software. Microsoft® .NET 

4.6.1 is required for FAM version 2021.01. The installation will upgrade your current .NET Framework 
version if required. You will need internet access to download the .NET installation files. When prompted, 
select Yes to continue or select No to exit the installation. 

 
 
 

NOTE: Some operating systems may require a reboot. A message will appear indicating a reboot is 
necessary. Follow the instructions to reboot. When system is back up, login and start the FAM 
installation again (repeat steps 1- 15 and then continue with step 17). 
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19. Web Deploy 3.5 is required to be installed if not already present. When prompted, select Yes to 
continue or select No to exit the installation. 

 
20. Select Typical as the Setup Type when prompted. Select Install. 

 

 
 
 
 

21. To enable first time use of the 2021.01 release, IT personnel (preferable) or a user must open the 
application and from File/Update License, navigate to the 2021 Permission Key that was downloaded 
from the Software Delivery Manager. Failure do so will generate incorrect licensing messages. You will 
see this reminder message.  
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22. Setup Complete opens. 
 

 

 
 
 
 

    NOTES:  

 
To enable first time use of the 2021.01 release IT personnel (preferable) or a user must 
open the application and from File/Update License, navigate to the 2021 Permission Key 
that was downloaded from the Software Delivery Manager. Failure do so will generate 
incorrect licensing messages.  

 

   



8 

R2021.01 

 

23. To complete the installation process, click Finish. The following message appears, asking you to set up 
the workstation(s) needed to access the program: 

 

 
 
 

Workstation setup will need to be performed on each workstation that will access FAM on the 
Network. Normally this is done after the Fixed Assets Manager databases have been created, but it can 
run any time after the application has been successfully installed. See FAM Workstation Setup below. 

 

 
 
 
 
Setting Up the Fixed Assets Manager Databases 

 
Fixed Assets Manager is designed to use Microsoft® SQL Server as a data engine for its multi-user, network 
installations. If you are using the Network version of Fixed Assets Manager, your database administrator must 
manually set up the system and user databases before you can use the program. 

 

 
Database Recommendations 

 
We recommend that a database maintenance routine be created. For more information, refer to the ‘Database 
Maintenance wizard’ in the Microsoft® SQL Server Books Online. We recommend that a qualified SQL Server 
DBA perform these tasks when in a production environment. 

 

 
Order of Events 

 
The following steps are required to access the Fixed Assets Manager program: 

 
1. Attach the new databases for network (multi-user) installations. 

 
a. Attach the system database. 

 
Note: A system database must exist on each server where a user database is created. Only one 
system database should be attached on each server. 

 
b. Attach the user database(s). 

 
2. Create users and grant them rights. 

 
3. Grant execute permissions on stored procedures. 

 
4. Setup the FADBNAMES.fad file. 
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1. Creating New Databases for Network (Multi-user) Installations 
 

 
U Attaching Empty Database Files 

 

To create the databases, attach the system database and the user database to your SQL Server instance by 
using SQL Server Management Studio. 

 
Note: The detached database files are located in the DATABASES folder on the Fixed Assets Manager 

installation image. If the database server is not already registered, register the server in Management 
Studio. For more information, refer to ‘How to: Create a New Registered Server (SQL Server Management 
Studio)’ in the Microsoft® SQL Server Books Online. 

 

 
 
 

1) System Database 
 

To attach a Fixed Assets Manager system database (FASYS): 
 

1. The FASYS.MDF database file is located in the DATABASES folder on the Fixed Assets Manager 
installation image. Copy the FASYS.MDF file to the location where the SQL Server instance is located. 
Verify that the FASYS.MDF file does not contain the Read-only attribute. 

 
2. Open SQL Server Management Studio. 

 
3. In SQL Server Management Studio, expand the database server where the database will reside. 

 
4. Select the Databases folder on the database server and right- click. 

 
5. From the list, select Attach. 

 
6. Click the Add button and browse to the location where your system data file (FASYS.MDF) is located. 

 
Note: The ‘Attach as’ field, displays the default database name. Do not change the system data 
filename. 

 
7. In the ‘”fasys” database details’ section, highlight the fasys_log.LDF file and click the Remove button. 

 
8. Click the OK button. 

 
9. When the database is successfully attached, you will see ‘fasys’ listed under the Databases folder. 

 
2) User Database 

 
To attach the Fixed Assets Manager user database (the default name is FADATA): 

 
1. The FADATA_data.MDF database file is located in the Databases folder on the Fixed Assets Manager 

image. 
 

2. Copy the FADATA_data.MDF file from the image folder to the location where the SQL Server instance is 
located. 

 
3. Verify that the FADATA_data.MDF file does not contain the Read-only attribute. 

 
4. Open SQL Server Management Studio. 

 
In SQL Server Management Studio, expand the database server where the database will reside. 
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5. Select the Databases folder on the database server and right-click. 
 

6. From the list, select Attach. 
 

7. Click the Add button and browse to the location where your user data file (FADATA_data.MDF) is 
located. 

 
Note: The ‘Attach as’ field, displays the default database name. Do not change the user data filename. 

 
8. In the ‘fadata’ database details’ section, highlight the fadata_log.LDF file and click the Remove button. 

 
9. Click the OK button. 

 
10. When the database is successfully attached, you will see ‘fadata’ listed under the Databases folder. 

 
 
 
 
2. Creating Users and Granting Rights 

 
For Fixed Assets Manager to run correctly, the application needs access to the SQL Server engine. You can 
access this either through a ‘trusted connection’ using Windows authentication or a ‘non-trusted connection’ using 
SQL Server authentication. Check your internal IT policies to determine if either method of authentication is a 
preference or requirement. This connection must be created for each Fixed Assets Manager user.  Certain rights 
and permissions must be assigned to the connection. 

 
Note: We recommend creating a domain Users Group for users of the Fixed Assets Manager application. 
Database access can then be granted to the group. Using groups allows you to manage many users with a 
single step. 

 

 
UOption A) Creating a Trusted ConnectionU                        (Recommended) 

 

A trusted connection means that a user will connect to the database using Windows Authentication. 
 
To create users who will access Fixed Assets Manager through a trusted connection\Windows authentication: 

 
1. Open SQL Server Management Studio. 

 
2. Expand the REDMOON database server, select Security and then Logins. 
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3. Right-click on Logins and select New Login. Login - New opens. 
 

 
 

4. Click the Search button next to the Login Name field. 
 

5. Select the Advanced button. 
 

6. Select the Object Types… button. Verify that Users and Groups is selected. 
 

7. Verify the name of your company’s network domain appears under the ‘From this Location’ heading. If not, 
select the Locations… button to select the appropriate domain account network. 

 
8. Select the Find Now button. A list of your domain user and group accounts should appear. 

 
9. Select the User or Group (recommended) and hit the OK button. 

 
10. Hit OK again on the Select User or Group dialog screen. 

 
11. Select ‘User Mapping’ under ‘Select a page’ area of the Login - New dialog. 

 
12. Under the ‘Users mapped to this login:’ area, select the fadata database. 
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13. Select the following roles for the fadata database: 
 

db_datareader, db_datawriter, db_ddladmin, public 
 

 
 

Note: In order for a user to create Accounting Information Fields within Fixed Assets Manager, 
they must have either db_ddladmin or db_owner access to the FADATA database. Without 
these rights, users will not be able to create or delete Accounting Information Fields and may have 
problems backing up entities, and restoring entities. Users with db_owner access can change 
entity access within the program. For more information, refer to the Setting up Access to Entities 
section. 

 
14. Select the following roles for the fasys database: 

 
db_datareader, public 
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15. Hit OK. The user will now have a trusted connection. 
 

16. If you did not grant rights to a Users Group, you must repeat steps 2 through 14 for each individual 
Fixed Assets Manager user. 

 
 
 

UOption B) Creating a Non-Trusted Connection 
 

A non-trusted connection means that a user will connect to the database using SQL Server authentication. 
 
Create users who will access Fixed Assets Manager through a non-trusted connection\SQL Server authentication: 

 
1. Open SQL Server Management Studio. 

 
2. Expand the REDMOON database server, select Security and then Logins. 

 
3. Right-click on Logins and select New Login. Login - New opens. 

 
4. Select SQL Server Authentication, and then enter a user name in the Login Name field and a password 

in the Password field. 
 

5. Follow Steps 10 through 14 in the Creating a Trusted Connection section and click OK. The user will now 
have a non-trusted connection. 

 
6. Repeat for each Fixed Assets Manager user. Each user will need to be notified of their new Login Name 

and Password. 
 

 
UC) Granting Rights to Existing Users 

 

If user logins already exist when the user database is created, you can grant individual access to the user. 

To grant existing users rights to the new database: 

1. Open SQL Server Management Studio. 
 

2. Expand the REDMOON database server, select Security and then Logins. 
 

 
 

3. In the right pane, double-click the name of the user to whom you want to grant access. The Login 
Properties opens. 

 
4. Follow Steps 10 through 14 in the Creating a Trusted Connection section and click OK. The user will now 

have a trusted connection. 
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P                   P 

3. Granting Execute Permissions on the User Database(s) 
 
For Fixed Assets Manager to work correctly, each login or connection needs execute rights to the stored 
procedures in the user database. To grant an existing user or SQL group the execute permission to the stored 
procedures in FADATA (or your alternatively named user database): 

 
1. Open SQL Server Management Studio. 

 
2. Expand the RedMoon database server. 

 
3. Select Open from the File menu and navigate to the \FAPROG folder where the program is installed and 

open the FamGrantExecute.sql file. 
 

4. Verify that the database name specified on the USE line is correct (FADATA by default). 
 

Note: The FamGrantExecute.sql script grants the 'execute' privilege on stored procedures in the FADATA 
database to all users in the 'Public' database role. Your company policy may not permit granting this 
privilege to 'Public'. Step 5 is only necessary if you wish to grant execute privileges to someone else other 
than 'Public'. If you do not need to do this, skip Step 5 and proceed to Step 6. 

 
5. By default FamGrantExecute.sql grants permission to all users in the ‘Public’ database role. If you need to 

grant permission solely to a SQL group or individual, replace the word ‘Public’ with the new username or 
group: 

 
a) From the first ‘Grant’ line, select the word ‘Public’. 

 
Note: The ‘Find’ field should already display the word ‘Public’. If not, type in the word ‘Public’ in the 
‘Find’ field. 

 
b) From the Edit menu, select Replace. 

 
c) In the ‘Replace with’ field, enter a valid username and click Replace All. 

 
d) When the replace is complete, close Replace. 

 
6. To execute the query, press F5 or click the Execute button on the toolbar. 

 
7. Repeat Steps 5 and 6, as necessary, to grant another user execute permission. 

 
 
 
 
 
 
 
4. Setting Up the FADBNAMES.fad File 

 
The FADBNAMES.fad file is a text file, which is utilized only in Network (Multiuser) installations and includes all 
databases that the Fixed Assets Manager product can access. This file includes the name of the database, the 
location of the database, and a connection flag. This file is ignored in Local (Single Workstation) deployments of 
the software. 

 
To set up the Fixed Assets Manager FADBNAMES.fad file: 

 
1. In Windows® Explorer, navigate to the \FAPROG folder where the program is installed. 

 
2. Open the FADBNAMES.fad file with a text editor such as WordPad. 
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3. After the file is open, you can add, delete, or modify the database entries. The format for an entry is as 
follows: 

 
DatabaseName|Location|Connection Flag; 

 
where 

 
- DatabaseName equals the actual name of the database; 

 
- Location equals Server Name or IP Address; 

 
- Connection Flag equals 0 for Non-Trusted Connection or 1 for Trusted Connection. 

 
Example: FADATA|Your SQLServerDBName|1; 

Example: FADATA|123.123.123.123|1; 

Note:  The entry in the FADBNAMES.FAD file must be terminated with a semi-colon. Verify there are no 
spaces in the connection string. 

 
If you are using a named instance of SQL Server, and not the default instance, the entry should include 
the instance name. 

 
Example: Fadata|YourSQLServerDBName\YourInstanceName|1; 

 
4. After the modifications to the FADBNames.fad file are complete, save and close the file. 

 
 
 
 
5. Setting Up Access to Entities 

 
If you license the Enterprise version of Fixed Assets Manager, you have the option to allow and restrict users’ 
access to entities within the database. Please refer to the Entity Access section of the FAM_Security.pdf located 
in the FADOCUMENTS folder on the FAM installation image. 

 
Note: If you do not license the Enterprise version of Fixed Assets Manager, no action is required. Your database 
setup is complete. 



16 

R2021.01 

 

FAM Workstation Setup 
 
To install the FAM Workstation Setup: 

 
1. Close all applications running in Windows®. 

 
Note: If this is the initial installation of FAM, the computer may shut down and restart during the 
installation. Therefore, we highly recommend saving your work and closing all applications running on the 
workstation before installing the FAM workstation setup. 

 
2. To perform the workstation setup, map a drive to the location where the application was installed. Right 

click on the setup.exe file located in RedMoon\Faprog\Wksetup and select “Run as administrator”. 
When the User Account control window opens, select Yes to continue. 

 
3. The Welcome screen opens, select Next to continue. 

 

 
 
 
 
 
 

4. The Microsoft® Visual C++ 2015 Redistributable (x86) is required for the proper functioning of the FAM 
software. When prompted, select Yes to continue or select No to exit the installation. 

 
5. Microsoft® .NET Framework is required for the proper functioning of the FAM software. Microsoft® .NET 

4.6.1 is required for FAM version 2021.01. The installation will upgrade your current .NET Framework 
version if required. You will need internet access to download the .NET installation files. When prompted, 
select Yes to continue or select No to exit the installation. 
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NOTE: Some operating systems a reboot may be required. A message will appear indicating a reboot is 
necessary. Follow the instructions to reboot. When system is back up, start the FAM installation again 
(repeat steps 1- 5 and then continue with step 6). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. SAP Crystal Reports runtime engine for .NET Framework (32 bit) is required for the proper functioning of 
the FAM software. The installation will install SAP Crystal Reports runtime engine for .NET Framework (32 
bit) if it is not already installed. Select Yes if prompted. 

 
7. Once the workstation setup is finished, the Network Fixed Assets Manager application installation is 

complete. 
 
 
 
 

     
 

NOTE:  The Fixed Assets Manager program must be run in administrator mode the first 
time a user launches the program. Users should right click on the Fixed Assets Manager 
program on the Start menu and select “Run as administrator”. When the User Account 
control window opens, select Yes to continue. 
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Using Maintenance Mode 
 
Maintenance Mode is designed for databases that are used by multiple users. It is not necessary to use this for 
local databases. This utility is a convenient way to allow an end user to prohibit other end users from having FAM 
program access to the database. This allows end users to act in an administrative capacity without having to 
involve the local DBA. 

 
To ensure that you will have exclusive access to the database, place the database in Maintenance Mode. While 
in Maintenance Mode, no one else will be allowed to access this database. You can now modify or delete data in 
the database without any other user placing locks on the data. 

 
We recommend placing the database in Maintenance Mode before performing the following operations: 

 
• Add or delete Asset Types 

• Add or delete Accounting Information fields 

• Add or delete Books 

• Apply Asset Types 

• Renumber Assets 

• Perform a mass deletion of a large number of assets 

• Migrate a file into the database 
 

 
Note: Maintenance Mode is not necessary for routine user activity. 

 

 
Entering Maintenance Mode 

 
To enter Maintenance Mode: 

 
1. From the Tools menu, select Maintenance Mode. Fixed Assets Manager - Maintenance Mode opens. 

 

 
 

Notes: 
 

• Maintenance Mode always displays while you are in this mode. 

• If other users are logged on to this database when you attempt to enter Maintenance Mode, the 
following message appears: ‘System lock cannot be obtained at this time. This process requires 
exclusive use of the database. Active users are: {User’s Login Name, data and time the user logged 
into the database}.’ The users listed in the warning message need to log out of the database before it 
can be placed into Maintenance Mode. 

 
 

2. Make your changes. 
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3. To exit Maintenance Mode, click End Maintenance Mode. 
 
 
 
 
 
 
Maintenance Best Practices for Administrator (Network) 

 
Fixed Assets Manager will perform better with regular re-indexing and DBCC. The database administrator should 
perform this on a regular schedule. We include the script, FAM_Database_Maintenance.sql, in the FAPROG 
folder where the FAM application is installed. To perform database maintenance: 

 
1. Open SQL Server Management Studio. 

 
2. Expand the RedMoon database server and select the Fixed Assets Manager user database. 

 
3. Select Open from the File menu and navigate to the \FAPROG folder where the program is installed and 

open the FAM_Database_Maintenance.sql file. 
 

4. Verify that the database name specified on the USE line is correct (FADATA by default). 
 

5. To execute the query, press F5 or click the Execute button on the toolbar. 
 

 
 
 
 
 
 
 
 
Uninstalling the Fixed Assets Manager Program (Network) 

 
The following procedures describe how to uninstall Fixed Assets Manager from a shared drive (Network 
install). 

 

 
Uninstalling from Individual Workstations 

 
Note: You must uninstall workstations that have run Workstation Setup before uninstalling from a shared drive. 

 
1. From the Windows Start menu, select Settings, and then select Control Panel. 

 
2. In Control Panel, select the Add/Remove Programs icon. Add/Remove Program Properties appears. 

 
3. Select FAM Workstation Setup from the list, and click Change/Remove. FAM Uninstall opens. 

 
4. To uninstall Fixed Assets Manager, click Remove All. When the successfully completed message 

appears, click OK. To cancel the uninstall process, click Exit. 
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®

Uninstalling from a Shared Drive 
 
Use this procedure to uninstall Fixed Assets Manager from a shared drive. 

 
Important: Before uninstalling the program from the shared drive, be sure that the Workstation Setups have 
been removed from all individual workstations. For more information, refer to the Uninstalling from Individual 
Workstations section. 

 
1. In Microsoft®® Explorer, browse to the FAPROG folder on the network drive where the Fixed Assets 

program was installed. 
 

2. In the FAPROG folder, double-click Aauninst.exe to run the file. FAM Uninstall opens. 
 

 
 
 
 

3. From FAM Uninstall, click Remove All. 
 

Note: To cancel the uninstall process without uninstalling the FAM program, click Exit. 
 

4. When the successfully completed message appears, click OK. 
 

5. In Microsoft®P                 Explorer, browse to the RedMoon\FAPROG folder on the network drive where the Fixed 
Assets program was installed and verify no program files exist. If some program files still exist, delete all 
remaining files in the FAPROG folder. 
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Accessing Customer Support 
 
You can access CCH Customer Support at 800.739.9998.  For product support choose Option 2 then Option 3. 
For installation or technical support choose Option 4 then Option 1 then Option 2.  

 
For more information about using the Fixed Assets Manager program, refer to the topic ‘Getting Started’ under 
the ‘Fixed Assets Manager Online Help’ section in the program’s Help system. 
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